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Noteworthy News 
 
 

Procurement Services is Moving! 
 
DAS Procurement Services is moving up in world!  Actually we are 
moving up to the 5th Floor here at the State Office Building.  
Effective December 18, 2003, any correspondence that is mailed 
should be addressed as follows: 
 

DAS Procurement Services 
Attn: (Persons Name Here) 

165 Capitol Avenue 
5th Floor South Wing 

Hartford, CT 06106 
 

Bids or any material that is hand carried into the building should be delivered to the DAS 
Customer Service Desk, which is located on the First Floor in Room 110.  All vendors and 
visitors that wish to conduct business with anyone in Procurement or Business Connections 
should report Room 110.   From there you will be escorted to the 5th Floor. 
 
Stayed tuned to future issues of WIN for further information and updates. 
 
 
 
 

What's Happening with Buy Smart...Buy Together?   
 

 
 
Recently the Buy Smart...Buy Together team successfully completed Phase I (Understanding 
the Opportunity) of the initiative and is aggressively moving into Phase II (Savings Creation).  
Use the following link to access the letter from DAS Commissioner Barbara Waters to Agency 
Heads that summarizes where we've been and where we're going with this initiative.   
 

Buy Smart…Buy Together Letter 
 
How can you be involved?  Read on!  We're planning our first Buy Smart Buy Together Agency 
Forum, which will be geared towards state agency purchasing staff.  At the forum, we will 
update you on the ways you and your agency can assist in this effort, support future contracts, 
and ensure future cost savings.  If you are involved in state purchasing, you are invited to attend 
the: 
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http://www.das.state.ct.us/rfpdoc/BuySmartLetter.pdf


 
Buy Smart…Buy Together Agency Forum 

 
January 22, 3003 

8:30 – 11:30 
 

Dept. of Transportation 
2800 Berlin Turnpike 

Newington, CT 
 

Use the links below to access the registration form or to review any of the previous WIN articles 
about... 
 
 
 
 
 
 

Registration Form  
 

 
Special Edition    WIN Article Oct 31   WIN Article Nov 21 

 
 
 

e-Partners 
 

“Partnering with Connecticut’s Municipalities, Schools and Non-Profit 
Organizations” 

Procurement Services is planning a Forum and we’d like your help!   
 
On February 3, 2004, DAS will be hosting a forum just for Connecticut 
municipalities, schools and non-profit organizations.  Don’t miss this 
opportunity to meet with Procurement Services personnel and your 
purchasing colleagues from around the state.  Learn the latest information 
about DAS contracts and programs!  Participate in round table discussions!  
Take advantage of having our procurement personnel available to you in one 
location to get answers to your questions!  So far, suggested topics include 
the following: 
 

• Contractor Prequalification Program 
• New Indoor Air Quality (mold), Lead and Asbestos Consulting and Remediation 

Contracts 
• MTBE-free gasoline  
• Supplier Diversity Program 
• It’s up to you.  We need your input! 
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http://www.das.state.ct.us/rfpdoc/SpendForumRegistrationForm.doc
http://www.das.state.ct.us/rfpdoc/WINSpend101603.pdf
http://www.das.state.ct.us/rfpdoc/Buy103103.doc
http://www.das.state.ct.us/rfpdoc/Buy112103.doc


It’s your forum; tell us what you’d like to see!  Contact Barbara with your suggestions or 
ideas on what topics you would like to discuss.  She can be reached via email at 
barbara.moser@po.state.ct.us or phone her at 860-713-5081. 

 
 
 
Remember! Save the date – February 3, 2003 and watch future issues 
of WIN for location and time of the forum! 
 
 

 
 

Surplus Vehicle Auction…Saturday, December 13, 2003 
 
 DAS State Surplus will be hosting a public auction of over 
260 surplus vehicles on Saturday, December 13, 2003 at 
10:00 a.m. at the State Surplus Facility, 60 State Street, 
Wethersfield, CT.  There will be Ford Crown Victoria’s, various 
SUV’s and trucks, cargo and mini vans, motorcycles, school 
buses, fire trucks along with numerous boats, including a 
Boston Whaler!  For a detailed list, pictures and auction 
guidelines, use the following link to access the State Surplus 
auction web page:  
 

http://www.das.state.ct.us/Surplus/display_auction.asp 
 
 

US Foodservice Price List for Week of December 12, 2003 
 
To assist you with preparing your orders for food and janitorial supplies from 
US Foodservice we are attaching an Excel file with the prices that will be in 
effect for the week of December 8, 2003.   
 

Price List for Week of December 12, 2003 
 

 

 
"Got Stuff?" to the Rescue! 
 
On December 8, WTNH Channel 8 reported that crooks had put a 
damper on the holiday season for some 8th graders in New Haven.  
New Haven’s Sacred Heart St. Peter School was recently robbed, and 
among the missing items were six laptop computers.  The news report 
concluded by saying that school officials and students were “hoping 
some holiday magic would somehow help replace their laptops.” 
 
On Tuesday, DAS sprang into action.  In conjunction with DAS Communications, DAS’ Linda 
Hubeny worked quickly to find six Gateway computers, along with computer keyboards and 
speakers that were submitted during the “Got Stuff?” surplus property campaign.  By the end of 
the day, DAS had contacted the school’s principal to share the good news.   
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“Especially with the holidays approaching, we’re so happy to announce this donation,” 
Commissioner Barbara Waters said.  “Our staff deserves a lot of credit for acting swiftly 
to help out these students.  We’ve turned what could have been an unfortunate story into 
a very happy one.” 
 
Lt. Governor Jodi Rell will be visiting the school to present the six donated computers.  
Channel 8 is expected to cover the event. 
 
The following is a transcript of Tuesday’s Channel 8 story: 

State steps in to replace stolen computers 

(New Haven-WTNH, Dec. 9, 2003 4:10 PM) _ Connecticut is donating six computers to 

a New Haven school to replace ones stolen.   

The Connecticut Department of Administrative Services is donating the six Pentium 3 

computers to New Haven's Sacred Heart St. Peter School. 

The computers come from the DAS's Got Stuff surplus property collection initiative in 

which underused or unused items are redistributed. 
 
 

Vendor Spotlight??? 
 

Who would you like to see in the “spotlight?” We want to give our vendors 
an opportunity to “shine” and “broadcast” the products and services they 
provide.  Let us know what contracted vendors/businesses you would like to 
see featured in this new addition to our newsletter.  Vendors, here is a great 
opportunity to be on center stage and let your products and services be 
known! Contact Teresa Dupont at teresa.dupont@po.state.ct.us with your 
requests and suggestions. 

 
 
 

Core-CT Information 
  

 
 

New Hours For Financials Users On Saturdays After Payday 

 
Effective, December 13, 2003, users will not have access to the Core-CT Financials application 
after 12 noon on Saturdays following a pay date. The Financial application will be brought down 
at noon. 
 
Financial system users who also have access to EPM or HRMS will continue to be able to use 
those applications. Users will be able to sign back on, but will not be granted access to any of 
the Financials areas. 
 
Don't forget to save your work before noon. 
 
If you have a question, please contact the Core-CT Helpdesk at (860) 622-2300; press 1 for 
Financials or press 2 for HRMS. Or you may send e-mail to core.support@po.state.ct.us 
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Looking for Catalog Items in Core-CT/PeopleSoft?  
Use the following link to access the listing of the vendors, contract number and 
contract name that have been loaded into the Core-CT catalog. 
 

Core-CT Catalog 

Getting Help Quickly And Easily 
 

Click on the “help” link to access all the Core-CT help links and phone numbers 
that are available to you. 
 

HELP 
 

 
 
 
 

 “Certification Central” 

 

  

The link below lists the name, contact information, product description 
and certification type of all the Connecticut small businesses that were 
certified during the previous week.  Contact Meg Yetishefsky with any 
comments or suggestions at meg.yetishefsky@po.state.ct.us or (860) 
713-5228. 
 

Newly Certified! – 12/01/03 through 12/05/03 
 
 
 
 
 

Peppy’s Toolbox 
 
Click on the “toolbox link” at the right to help yourself to any of the helpful 
“tools” (electronic forms) that are available to you. 
 
 
 
 

WINning Ways! 
  
Do YOU know of any person(s) who should be commended for a job well 
done?  Send your WINing Ways nominees to me at 
peppy.procurement@po.state.ct.us. 
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Ask Peppy! 

 

Peppy, 
 
Help!  Lately, it seems that every time I’m in a meeting, there are 
people who are very disruptive.  I am not sure if they realize it or 
not, but when they talk at the same time as the presenter it can be 
so distracting!  Do you have any kind of “meeting etiquette” or 
“meeting rules” that you can share with your readers? It can be so 
frustrating when you are trying to speak or listen and other 
conversations are going on. 
 

Anonymously Annoyed 
 
 
 
Dear AA, 
 
I can understand your frustration.  Yours is a very common complaint.  You will be pleased to 
know that I did some research on the Internet and found “Eleven Commandments for 
Business Meeting Etiquette” by Gary M. Smith.  Because it is information that many people 
can benefit from I have it as a link in Peppy’s Points to Ponder below.  Please feel free to print 
it out and hang it in a prominent place in your office just as a friendly reminder to everyone.  If 
you are the presenter at the meeting, why not mention a few of the rules before you begin to 
ensure that the meeting runs without these disruptions?  
 
I am sure that once people read these little but important reminders, you will see an 
improvement in your meetings.  Please keep me posted and keep these questions coming…I 
just love to help out when I can! 
 
Peppy 
 
Do you have a purchasing question and you can’t seem to find the answer? Send it to me at 
peppy.procurement@po.state.ct.us and I will do my best to find the answer for you and post it in 
a future issue of WIN.  
 
 

Peppy’s Points to Ponder… 
 
In response to “Ask Peppy” please click on the following link. It is definitely well 
worth it! 
 
“Eleven Commandments for Business Meeting Etiquette” 

 
 
C’mon WINners.  I know there are lots of positive quotes and sayings that are 
out there.  Why not share them and help to brighten someone’s day or give them a 
“point to ponder!”  Don’t be shy. Please take a minute to send them to me at 
peppy.procurement@po.state.ct.us. 

 7

mailto:peppy.procurement@po.state.ct.us
http://www.das.state.ct.us/rfpdoc/ElevenCommandments.pdf
mailto:peppy.procurement@po.state.ct.us


 
 
 

 
Tech Talk with Ms. Bits n’ Bytes 
 

Word Tip: Watermarks 
 
Inserting a watermark once took some effort, leading many people to 
buy paper with preprinted watermarks. Word makes it extremely 
simple to print pages with your own custom background images and 

text. The image is barely visible behind the text and adds a touch of class to all your 
memos, resumes, and more.  

1. Choose Page Layout from the View menu.  
2. Go to the Format menu, click Background, and choose Printed Watermark. 

o For picture watermarks, click Picture Watermark and Select Picture. Find the 
image you want to use on your hard drive and click Insert.  

o For text watermarks, choose Text Watermark and type the text you'd like to 
use. 

3. Tweak your options and press Apply. 

The process is less obvious in Microsoft Word 97 and 2000, but still possible.  

1. Choose Page Layout from the View menu.  
2. Choose Picture from the Insert menu, find the image you want to use on your hard 

drive, and click Insert.  
3. Click Format and Picture.  
4. Under the Picture tab, go to Image Control and choose Watermark as the color.  
5. In Word 97, choose None from the Wrapping tab. In Word 2000, set Behind Text as 

the wrapping style under the Layout tab.  
6. Press OK. 

The watermark will print in the background of every page of the document 
 

 
Ms. Bits and Bytes WEBSITE of the week:  
 

AbsoluteTrivia.com 
 

In this page full of trivia, you can search for facts by keyword or browse through the various 
categories. Get information on topics from animals, entertainment and inventions to technology, 
statistics and space. Multiple choice trivia quizzes test your knowledge in a number of areas. 
Learn about the famous people who were born on this day and the historical events that took 
place. 
 
Please write to me and let me know if you have a computer question, problem or perhaps just 
something you would be interested in learning about.  You can email me at: 
maureen.blackburn@po.state.ct.us   
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Bid Notice Postings 

 
To view the entire DAS bid notice listing, click on the following hyperlink to go 
to our web page.  DAS Bid Notices 

 

Contract Information: 

DAS Contracts 
The following is a listing of contracts issued during the week of 12/08/03: 

Contract # Contract Name For: Contract Term 

03PSX0407 
Surveying Equipment for the 

Dept. of Transportation.  Trimble 
Mapping Grade and Surveying 

Grade Receivers. 

Department of 
Transportation 

December 2, 2003 
through  

May 30, 2004 

03PSX0422 Purchase of Concrete Blocks 
and Bricks 

Department of 
Transportation, All 

Using State Agencies 
and Political 

Subdivisions of the 
State 

No Award 

 

Contracts Expiring 

 
Did you know that our state contracts are reviewed one to three months prior to the actual 
expiration date?  During this review process, the contract specialist examines the specifications 
and products/services included within each contract  

Contract Search  
 

Click on the list of “Contracts Issued/Expiring In Last/Next 30/60/90/120 Days”.  Choose the 
radio button marked “Expiring Contracts” and select the time frame.   
Then click “Get Contracts”.  That’s all there is to it! 

 

 
 

 
Keep up to speed with what’s happening in the  

 
 

 
Department of Information Technology 
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----------------------------- 
 

Contracts & Purchasing Division Information 
 
 
Need to contact someone at DOIT?  Click here to link to the DOIT Contact 
Information page of their web site. 
 
 

DOIT Bid/ Proposals 
 

• Click on the following hyperlink DOITBidPostingNotices to jump to DOIT’s Bid Posting Notices 
section of their web page.  

 

DOIT Contract Awards 
• Click on the following hyperlink DOITContractAwards to jump to DOIT’s Contract Award section 

of their web page.  
 

 

Contact Us 
If you know someone who may be interested in receiving this newsletter, have him or her 
send an email to teresa.dupont@po.state.ct.us and they will be added to our mailing list. 
Likewise, if you do not wish to receive this email, send us a note and your name will be 
removed.  
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